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experimental

> Overview :: Ready-to-use files
> Ready-to-use files / In-context visuals
> In-context visuals / Inspiration
> Element overview :: Primary elements
> Element overview :: Secondary elements
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E X P E R I M E N T A L  : :  O V E R V I E W  : :  R E A D Y - T O - U S E  F I L E S

Limited
edition 2

Limited
edition 1

Limited
edition 3

Bottle sleeve

Ready-to-use files
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Limited edition 2
FILE NAME: 450198

Limited edition 1
FILE NAME: 450197

E X P E R I M E N T A L  : :  R E A D Y - T O - U S E  F I L E S  /  I N - C O N T E X T  V I S U A L S

>
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Bottle sleeve
FILE NAME: 450201

E X P E R I M E N T A L  : :  R E A D Y - T O - U S E  F I L E S  /  I N - C O N T E X T  V I S U A L S

Limited edition 3
FILE NAME: 450199

>

>
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Sweatshirt | Man | Orange front | White sleeves
FOR REFERENCE ONLY

Sweatshirt | Man | White front | Orange sleeves
FOR REFERENCE ONLY

E X P E R I M E N T A L  : :  I N - C O N T E X T  V I S U A L S  /  I N S P I R A T I O N

Shirt | Woman | Orange
FOR REFERENCE ONLY

Shirt | Woman | White
FOR REFERENCE ONLY
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Sweatshirt | Man | Orange
FOR REFERENCE ONLY

E X P E R I M E N T A L  : :  I N - C O N T E X T  V I S U A L S  /  I N S P I R A T I O N
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E X P E R I M E N T A L  : :  E L E M E N T  O V E R V I E W  : :  P R I M A R Y  E L E M E N T S

Fanta logotype Pop bottle

Color palette

Pop bottle
lock-up

Pop orange
lock-up

People 
swirl 1

People 
swirl 2

People 
swirl 3

People 
swirl 4

Orange 
swirl

Strawberry
swirl

Hourglass /
Orange

Hourglass / 
Reverse

Hourglass / 
Yellow

Primary elements

Pop bubbles Pop bubbles /
Editable
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E X P E R I M E N T A L  : :  E L E M E N T  O V E R V I E W  : :  S E C O N D A R Y  E L E M E N T S

Oranges Lemons Strawberry Splash Splash / Outline

Font:
Helvetica

ABCDE FGH I J K LM
NOPQRS TU VWXY Z
a b c d e f g h i j k l m
n o p q r s t u v w x y z

1 2 3 4 5 6 7 8 9 0

Secondary elements

Hourglass / 
Digital / Orange

Hourglass /
Digital / Yellow

Hourglass /
Digital / Reverse

Font: Waldo

ABCDEFGHIJKLM

NOPQRSTUVWXYZ

abcdefghijklm

nopqrstuvwxyz

1234567890

Font:
Snoopskate

A B C D E F G H I J K LM
NOPQR S TUVWXYZ

1234567890

Font:
Candyshine

ABCDEFGHIJKLM
NOPQRSTUVWXYZ
abcdefghijklm
nopqrstuvwxyz

1234567890



do’s and
don’ts
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F A N T A  V I S U A L  I D E N T I T Y  S Y S T E M  G U I D E L I N E S
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D O ’ S  A N D  D O N ’ T S  

DO NOT mix elements from different activation 
quadrants in the same activation. The result will not
look and feel like the Fanta VIS. Here, elements from
the “Core” and “Experimental” quadrants are incorrectly
combined in one activation.

DO NOT mix ready-to-use files from different 
quadrants in the same activation. Here, a ready-to-
use file from the “Experimental” quadrant has been
incorrectly altered for POS by adapting the message
area and bottle art from the “Shared” quadrant.

DO NOT choose files from the wrong activation 
quadrant. Here, a ready-to-use file from the “Popular”
quadrant is incorrectly used for POS. This design is
from the wrong quadrant: it is not reaching the right
audience and is also lacking the necessary message area
for pricing. 

DO NOT create activations that exclude the universal
elements. This incorrect design does not use the Fanta
logotype and is not primarily Fanta Orange. Activations
that exclude the Fanta logotype and/or are not primarily
Fanta Orange are not acceptable.
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D O ’ S  A N D  D O N ’ T S  

DO NOT create activations without primary elements.
Universal and secondary elements alone are not enough
to create a Fanta look and feel. Primary elements — the
swirl, the Fanta splash bottle, and bubbles — are crucial
to creating activations which look like Fanta. The addition
of a swirl element to the art above would make it suitable
for Fanta.

DO NOT change relationships between elements
when adapting ready-to-use files. Here the scale of 
the Swirl + Lock-up 1 element gives incorrect promi-
nence to secondary elements: the Swirl connector and
the Floating oranges. Use existing ready-to-use files
and in-context visuals to guide your design. 

DO create customized art, but always get approval
from the Fanta design director in Atlanta. Here,
“Fanta” has been both translated and redesigned. 
In addition, a new flavor tag, as well as secondary 
people and support graphics have been created.
These customizations are all correct, but any one of
these changes requires approval.

DO NOT incorporate non-orange fruit elements into
ready-to-use files. Here, oranges have been incorrectly
replaced with strawberries instead of creating a custom
design for the flavor. The Fanta VIS is designed to be
orange-centric. 
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D O ’ S  A N D  D O N ’ T S  

DO NOT change 
the colors of the Fanta
color palette. The 
example above shows 
an element with the 
colors changed from 
the approved Fanta 
color breakdowns. 
When specifying colors
for printing, use the
color breakdowns 
provided in the primary
element summaries 
starting on page 68. 

DO NOT change or
switch the colors of 
elements or ready-to-
use files — not even to 
colors within the Fanta
color palette.

Colors in the element
above have been incor-
rectly switched. Colors 
in element files should
remain as provided.

DO NOT change the
relationship of elements
within a lock-up. Only
use individual elements if
a lock-up is not provided
for use.

The example above
shows three elements
incorrectly combined: 
the scale and relation-
ship to each other is
incorrect. Use a lock-up
when provided.

DO NOT add effects to
any element or ready-
to-use file.

The example above 
has a drop shadow
added. There is no 
provision in the Fanta
VIS for modification of
elements in this way.

DO NOT skew, distort
(as above) or otherwise
modify any individual
element in the Fanta
VIS.

The only exception is 
the Bubble burst swirl in
the “Popular” activation
quadrant. Please see 
page 81 for information
regarding this element.

DO NOT create new
elements! All approved
versions are included
with the Fanta VIS CD. 

The Fanta VIS provides
Hourglass files in three
colors: Fanta Orange,
reverse, and Fanta
Yellow. A Fanta Blue
version was not provided
and should not be added
or created.

DO NOT attempt to
recreate element art 
files — no matter how
seemingly simple. 

Here art has been 
created which resembles
the Splash. However, it 
is not the actual element
file and therefore not
authentically Fanta.
Always use the art 
files provided with the
Fanta VIS CD.

DO NOT change or
modify imagery style.
This example is more
photo-realistic than the
style of art included in
the Fanta VIS.
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element usage
specifications

F A N T A  V I S U A L  I D E N T I T Y  S Y S T E M  G U I D E L I N E S
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C O R E  : :  E L E M E N T  U S A G E  S P E C I F I C A T I O N S : :  P R I M A R Y  E L E M E N T S

Color palette
FILE NOT PROVIDED

Fanta Orange is both a
universal element and the
primary brand color. Fanta
Yellow, Fanta Green and
Fanta Blue are primary
elements and secondary
colors. Fanta is orange-
focused, both in flavor 
and color — so every
Fanta activation should 
be primarily orange, both
in focus and in color.

All elements and ready-
to-use files are set up as
flat (PANTONE®) colors,
except bottle photography,
which is CMYK. All Fanta
activations should ideally
be printed as flat colors to
ensure consistent color.
If printing in CMYK is nec-
essary, make sure CMYK
breakdowns for each color
match the numbers shown
above. Breakdowns are
also provided for digital
(RGB) color, above.

The Fanta color palette 
is one of our primary tools 
to create consistency
across the Fanta VIS. 
It is the same in all four 
activation quadrants.

Colors in these guidelines
have not been evaluated
by PANTONE®, Inc. for 
accuracy and may not
match the PANTONE® Color
Standards. PANTONE® is a
registered trademark of
PANTONE®, Inc.

Fanta Orange
PANTONE® 021 C 

C0 M53 Y100 K0

R255 G120 B0

Fanta Yellow
PANTONE® 123 C

C0 M24 Y94 K0

R255 G194 B17

Fanta Green
PANTONE® 361 C

C69 M0 Y100 K0

R79 G173 B78

Fanta Blue
PANTONE® Reflex Blue C

C100 M73 Y0 K2

R14 G43 B141

Fanta logotype
FILE NAME: 450973

The Fanta logotype is a
universal element and
Fanta’s primary brand
identifier. It should be
present — as either this
logotype file layered with
other elements or in a
lock-up file (such as 
Lock-up 1 or Swirl +
Fanta logotype) — in 
all Fanta activations. 

Bubbles
FILE NAME: 452632

F I L E  N A M E :  primary_bubbles.eps

Bubbles represent the
effervescence of Fanta.
This file is not usually
necessary in composing
activations since bubbles
are present and locked-
up appropriately in all
swirl files. Use this file for
composing or modifying
custom activations.

Swirl
FILE NAME: 450991

The dynamic swirl device
should be the focus of the
majority of activations.
The Swirl supports all
logotype lock-ups and is
itself supported by Swirl
lines. The Swirl should 
be centered within 
the lightest area of the
Background gradient. 

Fanta splash bottle
FILE NAME: 450026

The unique Fanta splash
bottle should be used
when possible. If the bot-
tle is not the focus of an
activation, this file should
be used. If it is the focus,
a lock-up file should be
used instead so that the
Fanta logotype is inte-
grated correctly.

Fanta splash bottle /
Outline
FILE NAME: 450026

This file also provides a
version of the Fanta
splash bottle with an
outline. It should be
used for activations with
complex or colored
backgrounds, which
the majority of Fanta
activations have.
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C O R E  : :  E L E M E N T  U S A G E  S P E C I F I C A T I O N S : :  P R I M A R Y  E L E M E N T S

Lock-up 1
FILE NAME: 450975

FILE NAME: lockup1.eps

The Lock-up 1 file con-
tains a lock-up of the
Fanta splash bottle with
the Fanta logotype. 
Use this lock-up when
accentuating the Fanta
splash bottle.

Lock-up 2
FILE NAME: 450976

Lock-up 2 contains a
lock-up of the Fanta
logotype with custom
oranges art. Use Lock-up
2 when the orange flavor
of Fanta is the focus.

Swirl + Fanta logotype
FILE NAME: 450993

The Swirl + Fanta logo-
type file contains a lock-
up of the Swirl and
Fanta logotype. This is
the most Fanta-dominant
of the swirl lock-ups.

Swirl + lock-up 1
FILE NAME: 450995

The Swirl + Lock-up 1
file contains a lock-up of
the Swirl, the Fanta
splash bottle and the
Fanta logotype. Of the
swirl lock-ups, this one is
the most focused on the
Fanta splash bottle.

Crop swirl + lock-up 1
FILE NAME: 450010

The Crop swirl + Lock-
up 1 file is a Fanta
splash bottle-focused
variation of the Crop
swirl. The Crop swirl +
Lock-up 1 file should also
be used trimmed to the
edge and not layered on
any background.

Crop swirl
FILE NAME: 450999

The Crop swirl is a stand-
alone version of the Swirl
+ Fanta logotype to be
used for POS activations.
The Crop swirl should be
used for activations such
as the Ceiling dangler
which is trimmed to the
edge. The Crop swirl
should not be layered on
any background.

Swirl + lock-up 2
FILE NAME: 450997

When the Swirl, the
Fanta logotype and the
orange flavor of Fanta
are the primary focus of
the activation design, use
this file. Swirl + Lock-up
2 contains a lock-up of
the Swirl, the Fanta
logotype and unique
orange art.
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C O R E  : :  E L E M E N T  U S A G E  S P E C I F I C A T I O N S : :  S E C O N D A R Y  E L E M E N T S

Background gradient /
Horizontal
FILE NAME: 450979

The Background 
gradient is the only
background used in 
the “Core” activation
quadrant. It already 
contains Swirl lines to
which the vortex of the
Swirl should be aligned.
This file should be used
for horizontal formats.

Background gradient /
Vertical
FILE NAME: 450978

The Background 
gradient is the only
background used in 
the “Core” activation
quadrant. It already 
contains Swirl lines to
which the vortex of the
Swirl should be aligned.
This file should be used
for vertical formats.

Background gradient /
Square
FILE NAME: 450977

The Background 
gradient is the only
background used in 
the “Core” activation
quadrant. It already 
contains Swirl lines to
which the vortex of the
Swirl should be aligned.
This file should be used
for square formats.

Swirl connector
FILE NAME: 450011

The Swirl connector may
already be familiar from
the Fanta packaging. It
is a dynamic arch which
draws the eye into the
Swirl. The arms can be
rotated and scaled to
adjust for activation for-
mat and swirl used, but
should remain parallel 
to each other.

Floating oranges /
Horizontal
FILE NAME: 450021

Use Floating oranges
when multiple oranges
are needed. It provides
multiples in correct 
scale and in a dynamic
composition. The file 
also includes registration
marks and trim lines for
use as a static. Use this
file for horizontal formats.

Floating oranges /
Vertical
FILE NAME: 450023

Use Floating oranges
when multiple oranges
are needed. It provides
multiples in correct 
scale and in a dynamic
composition. The file 
also includes registration
marks and trim lines for
use as a static. Use this
file for vertical formats.

Floating oranges / 
Square
FILE NAME: 450019

Use Floating oranges
when multiple oranges
are needed. It provides
multiples in correct 
scale and in a dynamic
composition. The file 
also includes registration
marks and trim lines for
use as a static. Use this
file for square formats.

Oranges
FILE NAME: 450012

There are three Oranges
provided: a whole
orange and two oranges
in cross-section. The
orange family should not
be used with other fruit.
These may be used to
supplement the Floating
oranges or in creating
custom art.
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C O R E  : :  E L E M E N T  U S A G E  S P E C I F I C A T I O N S : :  S E C O N D A R Y  E L E M E N T S

Lemons
FILE NAME: 450014

There are three Lemons
provided: a whole lemon
and two lemons in cross-
section. The lemon family
should not be used with
other fruit. 

Strawberry
FILE NAME: 450016

One Strawberry file is
provided. It should 
not be combined with 
other fruit. 

Font: Helvetica
FILE NOT PROVIDED

Helvetica is the preferred
font for legal or technical
information. Helvetica is
readily available in both
PC and Macintosh oper-
ating systems.

Message area
FILE NAME: 450988

FILE NAME:

message_area.eps

The Message area file
provides an area for 
messaging and pricing
information. There is also
a dynamic arch shape
which visually links and
integrates the message
area to the graphic area.

ABCDE FGH I J K LM
NOPQRS TU VWXY Z
a b c d e f g h i j k l m
n o p q r s t u v w x y z

1 2 3 4 5 6 7 8 9 0

Font: Waldo
FILE NAME: 522300

Waldo is provided for
display type, primarily
slogans. Please see the
Customization section 
for information about
modification of this font
for use in the Fanta VIS.
Waldo is included for use
in the Fanta VIS CD.

Font: Snoopskate
FILE NAME: 522299

Snoopskate is used for
pricing only, and is
included for use in the
Fanta VIS CD. Please see
the ready-to-use files or
in-context visuals for
examples of Snoopskate
in use in the VIS.

ABCDEFGHIJKLM

NOPQRSTUVWXYZ

abcdefghijklm

nopqrstuvwxyz

1234567890

A B C D E F G H I J K LM
NOPQR S TUVWXYZ

1234567890

ABCDEFGHIJKLM
NOPQRSTUVWXYZ
abcdefghijklm
nopqrstuvwxyz

1234567890

Font: Candyshine
FILE NAME: 522308

Candyshine is used
for flavor information.
Please see the section
on Customization for
information regarding
modification of this 
font in the Fanta VIS.
Candyshine is included
in the Fanta VIS CD.

Drops
FILE NAME: 452631

Drops reference the 
flavor of Fanta. This file is
usually not necessary in
composing activations as
Drops are present and
locked-up appropriately
in all Swirl files. Use this
file when composing 
custom activations.
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C O R E  : :  E L E M E N T  U S A G E  S P E C I F I C A T I O N S : :  S E C O N D A R Y  E L E M E N T S

Hourglass / Digital /
Orange
FILE NAME: 450990

The Hourglass device 
references the Fanta
splash bottle design. 
In the “Core” activation
quadrant, the Hourglass
should be used only in
digital activations such as
web or animation. The
orange version is the
preferred version for use.

Hourglass / Digital /
Reverse
FILE NAME: 450990

The Hourglass device 
references the Fanta
splash bottle design. 
In the “Core” activation
quadrant, the Hourglass
should be used only in
digital activations such as
web or animation. The
reverse version should
always be reversed out
of Fanta Orange.

Hourglass / Digital /
Yellow
FILE NAME: 450990

The Hourglass device 
references the Fanta
splash bottle design. 
In the “Core” activation
quadrant, the Hourglass
should be used only in
digital activations such as
web or animation. 

Swirl lines
FILE NAME: 450989

Swirl lines are a crucial
layering element of the
Fanta VIS — used with all
swirls except crop swirls
— placed beneath the
swirl but above the
Background gradient.
See page 71 for an
example of  Background
gradient lock-up files.
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S H A R E D  : :  E L E M E N T  U S A G E  S P E C I F I C A T I O N S : :  P R I M A R Y  E L E M E N T S

Color palette
FILE NOT PROVIDED

Fanta Orange is both a
universal element and the
primary brand color. Fanta
Yellow, Fanta Green and
Fanta Blue are primary
elements and secondary
colors. Fanta is orange-
focused, both in flavor 
and color — so every
Fanta activation should 
be primarily orange, both
in focus and in color.

All elements and ready-
to-use files are set up as
flat (PANTONE®) colors,
except bottle photography,
which is CMYK. All Fanta
activations should ideally
be printed as flat colors to
ensure consistent color.
If printing in CMYK is nec-
essary, make sure CMYK
breakdowns for each color
match the numbers shown
above. Breakdowns are
also provided for digital
(RGB) color, above.

The Fanta color palette 
is one of our primary tools 
to create consistency
across the Fanta VIS. 
It is the same in all four 
activation quadrants.

Colors in these guidelines
have not been evaluated
by PANTONE®, Inc. for 
accuracy and may not
match the PANTONE® Color
Standards. PANTONE® is a
registered trademark of
PANTONE®, Inc.

Fanta Orange
PANTONE® 021 C 

C0 M53 Y100 K0

R255 G120 B0

Fanta Yellow
PANTONE® 123 C

C0 M24 Y94 K0

R255 G194 B17

Fanta Green
PANTONE® 361 C

C69 M0 Y100 K0

R79 G173 B78

Fanta Blue
PANTONE® Reflex Blue C

C100 M73 Y0 K2

R14 G43 B141

Fanta logotype
FILE NAME: 450973

The Fanta logotype is a
universal element and
Fanta’s primary brand
identifier. It should be
present — as either this
logotype file layered with
other elements or in a
lock-up file (such as 
Lock-up 1 or Swirl +
Fanta logotype) — in 
all Fanta activations. 

Bubbles
FILE NAME: 452632

Bubbles represent the
effervescence of Fanta.
This file is not usually
necessary in composing
activations since bubbles
are present and locked-
up appropriately in all
Swirl files. Use this file for
composing or modifying
custom activations.

Swirl
FILE NAME: 450991

The dynamic swirl device
is the graphic heart of
the VIS and should be the
focus of any activation.
The Swirl supports all
logotype lock-ups and is
itself supported by Swirl
lines. The Swirl should 
be centered within 
the lightest area of the
Background gradient. 

Fanta splash bottle
FILE NAME: 450026

The unique Fanta splash
bottle should be used
when possible. If the bot-
tle is not the focus of an
activation, this file should
be used. If it is the focus,
a lock-up file should 
be used instead so that 
the Fanta logotype is
integrated correctly.

Fanta splash bottle /
Outline
FILE NAME: 450026ry_bottle.eps

This file also provides a
version of the Fanta
splash bottle with an
outline. It should be
used for activations with
complex or colored
backgrounds, which
the majority of Fanta
activations have.
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S H A R E D  : :  E L E M E N T  U S A G E  S P E C I F I C A T I O N S : :  P R I M A R Y  E L E M E N T S

Lock-up 1
FILE NAME: 450975

FILE NAME: lockup1.eps

The Lock-up 1 file con-
tains a lock-up of the
Fanta splash bottle with
the Fanta logotype. 
Use this lock-up when
accentuating the Fanta
splash bottle.

Lock-up 2
FILE NAME: 450976

Lock-up 2 contains a
lock-up of the Fanta
logotype with custom
oranges art. Use Lock-up
2 when the orange flavor
of Fanta is the focus.

Swirl + Fanta logotype
FILE NAME: 450993

The Swirl + Fanta logo-
type file contains a lock-
up of the Swirl and
Fanta logotype. This is
the most Fanta-dominant
of the swirl lock-ups.

Swirl + lock-up 1
FILE NAME: 450995

The Swirl + lock-up 1
file contains a lock-up of
the Swirl, the Fanta
splash bottle and the
Fanta logotype. Of the
swirl lock-ups, this one is
the most focused on the
Fanta splash bottle.
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S H A R E D  : :  E L E M E N T  U S A G E  S P E C I F I C A T I O N S : :  S E C O N D A R Y  E L E M E N T S

Background gradient /
Horizontal
FILE NAME: 450979

The Background gradient
is one of two background
options in the “Shared”
activation quadrant, this
one orange-dominant.
The file already contains
Swirl lines to which the
vortex of the Swirl
should be aligned. This
file should be used for
horizontal formats.

Background gradient /
Vertical
FILE NAME: 450978

The Background gradient
is one of two background
options in the “Shared”
activation quadrant, this
one orange-dominant.
The file already contains
Swirl lines to which the
vortex of the Swirl
should be aligned. This
file should be used for
vertical formats.

Background gradient /
Square
FILE NAME: 450977

The Background gradient
is one of two background
options in the “Shared”
activation quadrant, this
one orange-dominant.
The file already contains
Swirl lines to which the
vortex of the Swirl
should be aligned. This
file should be used for
square formats.

Background gradient
blue / Horizontal
FILE NAME: 450984

The Background gradi-
ent / blue is one of two
background options in
the “Shared” activation
quadrant, this one blue
and orange. The file
already contains Swirl
lines to which the vortex
of the Swirl should be
aligned. Use this version
for horizontal formats.

Background gradient
blue / Vertical
FILE NAME: 450983

The Background gradi-
ent / blue is one of two
background options in
the “Shared” activation
quadrant, this one blue
and orange. The file
already contains Swirl
lines to which the vortex
of the Swirl should be
aligned. Use this version
for vertical formats.

Background gradient
blue / Square
FILE NAME: 450980

The Background gradi-
ent / blue is one of two
background options in
the “Shared” activation
quadrant, this one blue
and orange. The file
already contains Swirl
lines to which the vortex
of the Swirl should be
aligned. Use this version
for square formats.

Swirl connector
FILE NAME: 450011FILE NAME:

swirl connector.eps

The Swirl connector may
already be familiar from
the Fanta packaging. It
is a dynamic arch which
draws the eye into the
Swirl. The arms can be
rotated and scaled to
adjust for activation for-
mat and swirl used, but
should remain parallel 
to each other.

Floating oranges /
Horizontal
FILE NAME: 450021

Use Floating oranges
when multiple oranges
are needed. It provides
multiples in correct 
scale and in a dynamic
composition. The file 
also includes registration
marks and trim lines for
use as a static. Use this
file for horizontal formats.
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S H A R E D  : :  E L E M E N T  U S A G E  S P E C I F I C A T I O N S : :  S E C O N D A R Y  E L E M E N T S

Floating oranges / 
Square
FILE NAME: 450019

Use Floating oranges
when multiple oranges
are needed. It provides
multiples in correct 
scale and in a dynamic
composition. The file 
also includes registration
marks and trim lines for
use as a static. Use this
file for square formats.

Oranges
FILE NAME: 450012

There are three Oranges
provided: a whole
orange and two oranges
in cross-section. The
orange family should not
be used with other fruit.
These may be used to
supplement the Floating
oranges or in creating
custom art.

Lemons
FILE NAME: 450014

There are three Lemons
provided: a whole lemon
and two lemons in cross-
section. The lemon family
should not be used with
other fruit. 

Floating oranges /
Vertical
FILE NAME: 450023

floating_oranges_vertical.eps

Use Floating oranges
when multiple oranges
are needed. It provides
multiples in correct 
scale and in a dynamic
composition. The file 
also includes registration
marks and trim lines for
use as a static. Use this
file for vertical formats.

Strawberry
FILE NAME: 450016

One Strawberry file 
is provided. It should 
not be combined with
other fruit. 

Font: Waldo
FILE NAME: 522300

Waldo is provided for
display type, primarily
slogans. Please see the
Customization section 
for information about
modification of this font
for use in the Fanta VIS.
Waldo is included for use
in the Fanta VIS CD.

Font: Snoopskate
FILE NAME: 522299

xxxxxxx

Snoopskate is used for
pricing only, and is
included for use in the
Fanta VIS CD. Please see
the ready-to-use files or
in-context visuals for
examples of Snoopskate
in use in the VIS.

ABCDEFGHIJKLM

NOPQRSTUVWXYZ

abcdefghijklm

nopqrstuvwxyz

1234567890

A B C D E F G H I J K LM
NOPQR S TUVWXYZ

1234567890

ABCDEFGHIJKLM
NOPQRSTUVWXYZ
abcdefghijklm
nopqrstuvwxyz

1234567890

Font: Candyshine
FILE NAME: 522308

Candyshine is used
for flavor information.
Please see the section
on Customization for
information regarding
modification of this 
font in the Fanta VIS.
Candyshine is included
in the Fanta VIS CD.
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Font: Helvetica
FILE NOT PROVIDED

Helvetica is the preferred
font for legal or technical
information. Helvetica is
readily available in both
PC and Macintosh oper-
ating systems.

ABCDE FGH I J K LM
NOPQRS TU VWXY Z
a b c d e f g h i j k l m
n o p q r s t u v w x y z

1 2 3 4 5 6 7 8 9 0

Message area
FILE NAME: 450988FILE NAME:

message_area.eps

The Message area file
provides an area for 
messaging and pricing
information. There is also
a dynamic arch shape
which visually links and
integrates the message
area to the graphic area.

2-bottle lock-up
FILE NAME: 450982

The 2-bottle lock-up
illustrates two 1L bottles,
but are intended to also
represent other bottle
types. This bottle art is to
be used in the Message
area to indicate item. 

4-bottle lock-up
FILE NAME: 450985

The 4-bottle lock-up
illustrates four 500mL
bottles, but are intended
to also represent other
bottle types. This bottle
art is to be used in the
Message area to indi-
cate item.

Car / People
FILE NAME: 450001

Car / People is intended
for use as a neutral 
people graphic for a 
variety of campaigns.

Beach / People
FILE NAME: 450008

Beach / People is the
people graphic intended
for use in the “Beach”
campaign.

Drops
FILE NAME: 452631FILE NAME:

primary_drops1.eps

Drops reference the 
flavor of Fanta. This file is
usually not necessary in
composing activations as
Drops are present and
locked-up appropriately
in all Swirl files. Use this
file when composing 
custom activations.

Swirl lines
FILE NAME: 450989

Swirl lines are a crucial
layering element of the
Fanta VIS — used with all
swirls except crop swirls
— placed beneath the
swirl but above the
Background gradient.
See page 76 for an
example of Background
gradient lock-up files.
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Outdoors / People
FILE NAME: 450017

Outdoors / People is 
the people graphic
intended for use in the
“Outdoors” campaign.

Outdoors / Birds
FILE NAME: 450025

Outdoors / Birds is a
background graphic for
use in the “Outdoors”
campaign.

Halloween / Orange
FILE NAME: 450020

Halloween / Orange is a
cleverly modified orange.
It is intended as a 
support graphic in the
“Halloween” campaign.

Outdoors / Trees
FILE NAME: 450025

Outdoors / Trees is a
background graphic for
use in the “Outdoors”
campaign.

Halloween / People
FILE NAME: 450004

Halloween / People is
the people graphic
intended for use in the
“Halloween” campaign.

Halloween / Bats
FILE NAME: 450020

Halloween / Bats is a
support graphic for
use in the “Halloween”
campaign.

Halloween / Stars
FILE NAME: 450020

Halloween / Stars is a
background graphic for
use in the “Halloween”
campaign.

Beach / Palm
FILE NAME: 450022

Beach / Palm is a 
support graphic for
use in the “Beach” 
campaign.
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Night / Stars
FILE NAME: 450024

Night / Stars is a 
background graphic
for use in the “Night”
campaign.

Hourglass / Digital /
Reverse
FILE NAME: 450990

The Hourglass device 
references the Fanta
splash bottle design. 
In the “Shared” activation
quadrant, the Hourglass
should be used only in
digital activations such as
web or animation. The
reverse version should
always be reversed out
of Fanta Orange.

Hourglass / Digital /
Yellow
FILE NAME: 450990

The Hourglass device 
references the Fanta
splash bottle design. 
In the “Shared” activation
quadrant, the Hourglass
should be used only in
digital activations such as
web or animation. 

Bamboocha font:
Fantasee
FILE NAME: 450194

As part of Fanta’s new
global advertising, Fanta
will soon launch the
“Bamboocha” campaign.
A custom Bamboocha
font, Fantasee, has been
created and is provided
for use in the Fanta 
VIS CD.

Hourglass / Digital /
Orange
FILE NAME: 450990

The Hourglass device 
references the Fanta
splash bottle design. 
In the “Shared” activation
quadrant, the Hourglass
should be used only in
digital activations such as
web or animation. The
orange version is the 
preferred version for use.

Night / People
FILE NAME: 450013

Night / People is the
people graphic intended
for use in the “Night”
campaign.
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Fanta logotype
FILE NAME: 450973

The Fanta logotype is a
universal element and
Fanta’s primary brand
identifier. It should be
present — as either this
logotype file layered with
other elements or in a
lock-up file (such as 
Lock-up 1 or Swirl +
Fanta logotype) — in 
all Fanta activations. 

Bubble burst swirl /
Reverse
FILE NAME: 450033

The Bubble burst swirl
is the main swirl in the
“Popular” activation 
quadrant. It is both
dynamic and memorable.
It can be used as is, or
with a variety of adapta-
tions. The adaptations
should be done with the
original file in Illustrator,
or a similar vector art

program. Use effects
like those to the right
(from left to right): an
envelope distort, shear
(transformation) and a
wrap effect. 

Please note that this is
the only element in the
Fanta VIS intended to be
modified in this manner!

Bubble burst swirl /
Orange
FILE NAME: 450033

Bubble burst swirl /
Yellow
FILE NAME: 450033

Bubble burst swirl /
Green
FILE NAME: 450033

Pop bottle
FILE NAME: 450042

The Pop bottle is a 
version of the Fanta
Splash bottle for use in
the “Popular” activation
quadrant. Use the Pop
bottle lock-up when the
bottle and the Fanta
logotype are the focus
of the activation.

Pop bubbles
FILE NAME: 450043

Bubbles represent the
effervescence of Fanta.
The Pop bubbles are the
only bubbles intended
for use in the “Popular”
activation quadrant.

Pop bubbles / Editable
FILE NAME: 450043

This file also contains
the Pop bubbles in an
editable format — not
converted from stroke
to outline — which
allows you to make
modifications to the file
if desired.
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Color palette
FILE NOT PROVIDED

Fanta Orange is both a
universal element and the
primary brand color. Fanta
Yellow, Fanta Green and
Fanta Blue are primary
elements and secondary
colors. Fanta is orange-
focused, both in flavor 
and color — so every
Fanta activation should 
be primarily orange, both
in focus and in color.

All elements and ready-
to-use files are set up as
flat (PANTONE®) colors,
except bottle photography,
which is CMYK. All Fanta
activations should ideally
be printed as flat colors to
ensure consistent color.
If printing in CMYK is nec-
essary, make sure CMYK
breakdowns for each color
match the numbers shown
above. Breakdowns are
also provided for digital
(RGB) color, above.

The Fanta color palette 
is one of our primary tools 
to create consistency
across the Fanta VIS. 
It is the same in all four 
activation quadrants.

Colors in these guidelines
have not been evaluated
by PANTONE®, Inc. for 
accuracy and may not
match the PANTONE® Color
Standards. PANTONE® is a
registered trademark of
PANTONE®, Inc.

Fanta Orange
PANTONE® 021 C 

C0 M53 Y100 K0

R255 G120 B0

Fanta Yellow
PANTONE® 123 C

C0 M24 Y94 K0

R255 G194 B17

Fanta Green
PANTONE® 361 C

C69 M0 Y100 K0

R79 G173 B78

Fanta Blue
PANTONE® Reflex Blue C

C100 M73 Y0 K2

R14 G43 B141

Bubble burst swirl +
pop bottle lock-up
FILE NAME: 450035

When the Pop bottle,
the Fanta logotype and
the Bubble burst swirl
are used, this lock-up
should be used. No other
color of the Bubble
burst swirl should be
used with the Pop bottle
and Fanta logotype.

Pop bottle lock-up
FILE NAME: 450029

The Pop bottle lock-up
file contains a lock-up of
the Pop bottle with the
Fanta logotype. Use this
lock-up in the “Popular”
activation quadrant when
accentuating the bottle.

Pop orange lock-up
FILE NAME: 450057

The Pop orange lock-up
includes the Fanta logo-
type and a Pop orange.
Please note that it is
intended to be used with
— not instead of — other 
logotype lock-ups. Use
this lock-up when you
want to accentuate the
orange flavor of Fanta.
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Background drops 1 /
Horizontal
FILE NAME: 450032

Background drops 1 are
one of two background
options in the “Popular”
activation quadrant, this
one orange on yellow.
This file should be used
for horizontal formats.

Background drops 1 /
Vertical
FILE NAME: 450032

Background drops 1 are
one of two background
options in the “Popular”
activation quadrant, this
one orange on yellow.
This file should be used
for vertical formats.

Floating pop oranges / 
Horizontal
FILE NAME: 450041orizontal.eps

Use Floating pop
oranges when many Pop
oranges are needed.
This file provides multi-
ple oranges in correct
scale and in a dynamic
composition. Use this file
for horizontal formats.

Background drops 2 /
Horizontal
FILE NAME: 450031

Background drops 2 are
one of two background
options in the “Popular”
activation quadrant, this
one yellow on orange.
This file should be used
for horizontal formats.

Background drops 2 /
Vertical
FILE NAME: 450031

Background drops 2 are
one of two background
options in the “Popular”
activation quadrant, this
one yellow on orange.
This file should be used
for horizontal formats.

Floating pop oranges / 
Vertical
FILE NAME: 450040

Use Floating pop
oranges when many Pop
oranges are needed.
This file provides multi-
ple oranges in correct
scale and in a dynamic
composition. Use this file
for vertical formats.

Floating pop oranges / 
Square
FILE NAME: 450039

Use Floating pop
oranges when many Pop
oranges are needed.
This file provides multi-
ple oranges in correct
scale and in a dynamic
composition. Use this file
for square formats.

Pop orange
FILE NAME: 450036

There is one Pop orange
provided for the “Popular”
activation quadrant. The
Pop orange should not
be used with other fruit.
It may be used to supple-
ment the Floating pop
oranges or in creating
custom art. 
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Pop strawberry
FILE NAME: 450038

There is one Pop 
strawberry provided for
the “Popular” activation
quadrant. The Pop
strawberry should not
be used with other fruit. 

Volleyball couple 1
FILE NAME: 450047

Volleyball couple 1 is one
of two primary people
graphics intended for use
in the “Beach volleyball”
campaign.

2-bottle lock-up
FILE NAME: 450982

The 2-bottle lock-up
illustrates two 1L bottles,
but are intended to also
represent other bottle
types. This bottle art is to
be used in the Message
area to indicate item.

4-bottle lock-up
FILE NAME: 450985

The 4-bottle lock-up
illustrates four 500mL
bottles, but are intended
to also represent other
bottle types. This bottle
art is to be used in the
Message area to indi-
cate item.

Font: Waldo
FILE NAME: 522300

Waldo is provided for
display type, primarily
slogans. Please see the
Customization section 
for information about
modification of this font
for use in the Fanta VIS.
Waldo is included for use
in the Fanta VIS CD.

Font: Candyshine
FILE NAME: 522308

Candyshine is used
for flavor information.
Please see the section
on Customization for
information regarding
modification of this 
font in the Fanta VIS.
Candyshine is included
in the Fanta VIS CD.

ABCDEFGHIJKLM

NOPQRSTUVWXYZ

abcdefghijklm

nopqrstuvwxyz

1234567890

ABCDEFGHIJKLM
NOPQRSTUVWXYZ
abcdefghijklm
nopqrstuvwxyz

1234567890

Font: Helvetica
FILE NOT PROVIDED

Helvetica is the preferred
font for legal or technical
information. Helvetica is
readily available in both
PC and Macintosh oper-
ating systems.

ABCDE FGH I J K LM
NOPQRS TU VWXY Z
a b c d e f g h i j k l m
n o p q r s t u v w x y z

1 2 3 4 5 6 7 8 9 0

Pop lemon
FILE NAME: 450037

There is one Pop lemon
provided for the “Popular”
activation quadrant. The
Pop lemon should not
be used with other fruit. 
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Volleyball players 1
FILE NAME: 450047

Volleyball players 1 is
one of two supporting
people graphics for use
in the “Beach volleyball”
campaign.

Beach / Drums
FILE NAME: 450044

Beach / Drums is one of
two supporting people
graphics for use in the
“Beach” campaign.

Volleyball players 2
FILE NAME: 450047

Volleyball players 2 is
one of two supporting
people graphics for use
in the “Beach volleyball”
campaign.

Volleyball / Setting
FILE NAME: 450053

Volleyball / Setting is a
background graphic for
use in the “Beach volley-
ball” campaign.

Volleyball / Net
FILE NAME: 450047

Volleyball / Net is a 
support graphic for use
in the “Beach volleyball”
campaign.

Beach couple 1
FILE NAME: 450044

Beach couple 1 is one 
of two primary people
graphics intended for use
in the “Beach” campaign.

Beach girl 1
FILE NAME: 450044

Beach girl 1 is one 
of two primary people
graphics intended for use
in the “Beach” campaign.

Volleyball couple 2
FILE NAME: 450047

Volleyball couple 2 is one
of two primary people
graphics intended for use
in the “Beach volleyball”
campaign.
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Beach / Setting
FILE NAME: 450052

Beach / Setting is 
a background graphic 
for use in the “Beach”
campaign.

Night girl 1
FILE NAME: 450049

Night girl 1 is one of 
six people graphics
intended for use in the
“Night” campaign.

Night couple 1
FILE NAME: 450049

Night couple 1 is one of
six people graphics
intended for use in the
“Night” campaign.

Night couple 2
FILE NAME: 450049

Night couple 2 is one of
six people graphics
intended for use in the
“Night” campaign.

Night couple 3
FILE NAME: 450049

Night couple 3 is one of
six people graphics
intended for use in the
“Night” campaign.

Night couple 4
FILE NAME: 450049

Night couple 4 is one of
six people graphics
intended for use in the
“Night” campaign.

Night couple 5
FILE NAME: 450049

Night couple 5 is one of
six people graphics
intended for use in the
“Night” campaign.

Beach / Trumpets
FILE NAME: 450044

Beach / Trumpets is 
one of two supporting
people graphics for use
in the “Beach” cam-
paign.
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Night / Disco ball
FILE NAME: 450049

Night / Disco ball is
intended as a support
graphic in the “Night”
campaign.

Parade couple 1
FILE NAME: 450051

Parade couple 1 is one
of five people graphics
intended for use in the
“Parade” campaign.

Parade couple 2
FILE NAME: 450051

Parade couple 2 is one
of five people graphics
intended for use in the
“Parade” campaign.

Parade guy 1
FILE NAME: 450051

Parade guy 1 is one of 
five people graphics
intended for use in the
“Parade” campaign.

Parade girl 1
FILE NAME: 450051

Parade girl 1 is one of 
five people graphics
intended for use in the
“Parade” campaign.

Parade girl 2
FILE NAME: 450051

Parade girl 2 is one of 
five people graphics
intended for use in the
“Parade” campaign.

Parade truck + people
FILE NAME: 450051

Parade truck + people is
a support graphic
intended for use in the
“Parade” campaign.

Night / Setting
FILE NAME: 450054

Night / Setting is 
a background graphic 
for use in the “Night”
campaign.
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Parade / Setting
FILE NAME: 450051

Parade / Setting is 
a background graphic 
for use in the “Parade”
campaign.

Parade truck
FILE NAME: 450051

Parade truck is intended
as a support graphic in
the “Parade” campaign.

Beach lock-up
FILE NAME: 450030

To emphasize each event 
campaign’s importance,
a unique event name
lock-up of the Fanta
logotype, Bubble burst
swirl and the event name
itself has been created.
This version should be
used instead of other
logotype lock-ups in the 
“Beach” campaign. 

Night lock-up
FILE NAME: 450030

To emphasize each event 
campaign’s importance,
a unique event name
lock-up of the Fanta
logotype, Bubble burst
swirl and the event name
itself has been created.
This version should be
used instead of other
logotype lock-ups in the 
“Night” campaign. 

Parade lock-up
FILE NAME: 450030

To emphasize each event 
campaign’s importance,
a unique event name
lock-up of the Fanta
logotype, Bubble burst
swirl and the event name
itself has been created.
This version should be
used instead of other
logotype lock-ups in the 
“Parade” campaign. 

Parade truck girl 2
FILE NAME: 450051

Parade truck girl 2 is
one of two supporting
people graphics
intended for use in the
“Parade” campaign.

Parade truck girl 1
FILE NAME: 450051

Parade truck girl 1 is
one of two supporting
people graphics
intended for use in the
“Parade” campaign.

Hourglass / Digital /
Orange
FILE NAME: 450990

The Hourglass device 
references the Fanta
splash bottle design. In
the “Popular” activation
quadrant, the Hourglass
should be used only in
digital activations such as
web or animation. The
orange version is the
preferred version for use.
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Hourglass / Digital /
Reverse
FILE NAME: 450990

The Hourglass device 
references the Fanta
splash bottle design. In
the “Popular” activation
quadrant, the Hourglass
should be used only in
digital activations such as
web or animation. The
reverse version should
always be reversed out
of Fanta Orange.

Hourglass / Digital /
Yellow
FILE NAME: 450990

The Hourglass device 
references the Fanta
splash bottle design. In
the “Popular” activation
quadrant, the Hourglass
should be used only in
digital activations such as
web or animation. 

Bamboocha font:
Fantasee
FILE NAME: 450194

As part of Fanta’s new
global advertising, Fanta
will soon launch the
“Bamboocha” campaign.
A custom Bamboocha
font, Fantasee, has been
created and is provided
for use in the Fanta
VIS CD.
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Fanta logotype
FILE NAME: 450973

The Fanta logotype is a
universal element and
Fanta’s primary brand
identifier. It should be
present — as either this
logotype file layered with
other elements or in a
lock-up file (such as 
Lock-up 1 or Swirl +
Fanta logotype) — in 
all Fanta activations. 

Hourglass / Orange
FILE NAME: 450990

The Hourglass device 
references the Fanta
splash bottle design.
The Hourglass is the 
primary swirl used in 
the “Experimental” 
activation quadrant.

Hourglass / Reverse
FILE NAME: 450990

The Hourglass device 
references the Fanta
splash bottle design.
The Hourglass is the 
primary swirl used in 
the “Experimental” 
activation quadrant.

Hourglass / Yellow
FILE NAME: 450990

The Hourglass device 
references the Fanta
splash bottle design.
The Hourglass is the 
primary swirl used in 
the “Experimental” 
activation quadrant.

Pop bottle lock-up
FILE NAME: 450029

The Pop bottle lock-up
file contains a lock-up 
of the Pop bottle with
the Fanta logotype. 
Use this lock-up in 
the “Experimental” 
activation quadrant to
accentuate the bottle.

Pop bottle
FILE NAME: 450042F I L E

N A M E :  primary_bottle.eps

The Pop bottle is a 
version of the Fanta
Splash bottle for use 
in the “Experimental”
activation quadrant. Use
the Pop bottle lock-up
when the bottle and the
Fanta logotype are the
focus of the activation.

Pop bubbles
FILE NAME: 450043

F I L E  N A M E :  

secondary_bubbles.eps

Bubbles represent the
effervescence of Fanta.
The Pop bubbles are 
the only bubbles
intended for use in the
“Experimental” 
activation quadrant.

Pop bubbles / Editable
FILE NAME: 450043F I L E

N A M E :  

secondary_bubbles.eps

This file also contains
the Pop bubbles in an
editable format — not
converted from stroke
to outline — which
allows you to make
modifications to the file
if desired.



Fanta Visual Identity System Guidelines 1.0 91Element usage specifications :: Experimental

E X P E R I M E N T A L  : :  E L E M E N T  U S A G E  S P E C I F I C A T I O N S : :  P R I M A R Y  E L E M E N T S

Pop orange lock-up
FILE NAME: 450057

The Pop orange lock-up
includes the Fanta logo-
type and a Pop orange.
Please note that it is
intended to be used with
— not instead of — other 
logotype lock-ups. Use
this lock-up when you
want to accentuate the
orange flavor of Fanta.

Strawberry swirl
FILE NAME: 450064

The Strawberry swirl is 
a dynamic swirl for use 
in the “Experimental”
activation quadrant. It
should not be used with
other fruit. 

Orange swirl
FILE NAME: 450064

The Orange swirl is 
a dynamic swirl for use 
in the “Experimental”
activation quadrant. It
should not be used with
other fruit. 

People swirl 1
FILE NAME: 450062

People swirl 1 is one 
of four people swirls 
in the “Experimental”
activation quadrant.
These unique dynamic
swirls are made up of
people representing our
target audience in con-
junction with the Pop
orange lock-up. 

People swirl 2
FILE NAME: 450059

People swirl 2 is one 
of four people swirls 
in the “Experimental”
activation quadrant.
These unique dynamic
swirls are made up of
people representing our
target audience in con-
junction with the Pop
orange lock-up. 

Color palette
FILE NOT PROVIDED

Fanta Orange is both a
universal element and the
primary brand color. Fanta
Yellow, Fanta Green and
Fanta Blue are primary
elements and secondary
colors. Fanta is orange-
focused, both in flavor 
and color — so every
Fanta activation should 
be primarily orange, both
in focus and in color.

All elements and ready-
to-use files are set up as
flat (PANTONE®) colors,
except bottle photography,
which is CMYK. All Fanta
activations should ideally
be printed as flat colors to
ensure consistent color.
If printing in CMYK is nec-
essary, make sure CMYK
breakdowns for each color
match the numbers shown
above. Breakdowns are
also provided for digital
(RGB) color, above.

The Fanta color palette 
is one of our primary tools 
to create consistency
across the Fanta VIS. 
It is the same in all four 
activation quadrants.

Colors in these guidelines
have not been evaluated
by PANTONE®, Inc. for 
accuracy and may not
match the PANTONE® Color
Standards. PANTONE® is a
registered trademark of
PANTONE®, Inc.

Fanta Orange
PANTONE® 021 C 

C0 M53 Y100 K0

R255 G120 B0

Fanta Yellow
PANTONE® 123 C

C0 M24 Y94 K0

R255 G194 B17

Fanta Green
PANTONE® 361 C

C69 M0 Y100 K0

R79 G173 B78

Fanta Blue
PANTONE® Reflex Blue C

C100 M73 Y0 K2

R14 G43 B141
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People swirl 3
FILE NAME: 4500060

People swirl 3 is one 
of four people swirls 
in the “Experimental”
activation quadrant.
These unique dynamic
swirls are made up of
people representing 
our target audience in
conjunction with the 
Pop orange lock-up. 

People swirl 4
FILE NAME: 450061

People swirl 4 is one 
of four people swirls 
in the “Experimental”
activation quadrant.
These unique dynamic
swirls are made up of
people representing 
our target audience in
conjunction with the
Pop orange lock-up. 
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Oranges
FILE NAME: 450012

There are three Oranges
provided: a whole
orange and two oranges
in cross-section. The
orange family should 
not be used with 
other fruit. 

Lemons
FILE NAME: 450014

There are three Lemons
provided: a whole lemon
and two lemons in cross-
section. The lemon family
should not be used with
other fruit. 

Strawberry
FILE NAME: 450016FILE NAME:

FF1_strawberry.eps

One strawberry file is
provided. It should not
be used with other fruit. 

Splash
FILE NAME: 450065

The Splash is a support
graphic which represents
a burst of flavor. 

Font: Snoopskate
FILE NAME: 522299

Snoopskate is used for
pricing only, and is
included for use in the
Fanta VIS CD. Please see
the ready-to-use files or
in-context visuals for
examples of Snoopskate
in use in the VIS.

A B C D E F G H I J K LM
NOPQR S TUVWXYZ

1234567890

ABCDEFGHIJKLM
NOPQRSTUVWXYZ
abcdefghijklm
nopqrstuvwxyz

1234567890

Font: Candyshine
FILE NAME: 522308

xxxxxxx

Candyshine is used
for flavor information.
Please see the section
on Customization for
information regarding
modification of this 
font in the Fanta VIS.
Candyshine is included
in the Fanta VIS CD.

Font: Waldo
FILE NAME: 522300

Waldo is provided for
display type, primarily
slogans. Please see the
Customization section 
for information about
modification of this font
for use in the Fanta VIS.
Waldo is included for use
in the Fanta VIS CD.

ABCDEFGHIJKLM

NOPQRSTUVWXYZ

abcdefghijklm

nopqrstuvwxyz

1234567890

Splash / Outline
FILE NAME: 450065

The Splash is a support
graphic which represents
a burst of flavor. This
Splash / Outline file is
provided with a white
outline to use for activa-
tions with complex or
colored backgrounds.
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Font: Helvetica
FILE NOT PROVIDED

Helvetica is the preferred
font for legal or technical
information. Helvetica is
readily available in both
PC and Macintosh oper-
ating systems.

ABCDE FGH I J K LM
NOPQRS TU VWXY Z
a b c d e f g h i j k l m
n o p q r s t u v w x y z

1 2 3 4 5 6 7 8 9 0

Hourglass / Digital /
Orange
FILE NAME: 450990

The Hourglass device 
references the Fanta
splash bottle design. 
Here the Hourglass is
provided for digital 
activations such as web
or animation. The orange
version is the preferred
version for use.

Hourglass / Digital /
Reverse
FILE NAME: 450990

The Hourglass device 
references the Fanta
splash bottle design. 
Here the Hourglass is
provided for digital 
activations such as web
or animation. This
reverse version should 
always be reversed out
of Fanta Orange.

Hourglass / Digital /
Yellow
FILE NAME: 450990

The Hourglass device 
references the Fanta
splash bottle design. 
Here the Hourglass is
provided for digital 
activations such as web
or animation. 
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CUSTOMIZATION : :  TYPOGRAPHY : :  FLAVOR TAGS

Here are the steps for creating flavor tags in the Fanta VIS.

1. Open the Fanta logotype file in Illustrator. With the
type tool from the toolbar, type in the flavor tag
(first letter uppercase) copy. See Example A.

2. Using the type tool, select the type. In the measure-
ments bar, specify a type size of 40 points (24 points
for longer flavor tags) and select Candyshine.

3. Double-click the scale tool in the toolbar. 
Select “Non-Uniform” and fill in values of 75% for
horizontal and 100% for vertical. See Example B.

4. Outline the flavor tag (Type > Create outlines).
Ungroup the letters (Object > Ungroup).

5. Selecting two letters at a time, make an envelope
with a mesh to reshape the object (Object >

Envelope Distort > Make with Mesh). For each 
group of two letters, specify two rows and one 
column. Continue with all letters.
See Example C.

6. Rotate the flavor tag by 30°.

7. Align the flavor tag to the left side of the bowl of
the first “a” in “Fanta.” If the copy extends past the
“t” in Fanta, then go to the smaller type size. Two
lines may be utilized for multi-word flavor tags.

8. Reshape the flavor tag with the mesh tool: 
reposition the mesh points and edit direction 
lines so that the flavor tag organically follows 
the Fanta logotype. 

9. Expand the envelope (Object > Envelope Distort >

Expand).

10. Assign the object Fanta Green.

11. Duplicate the flavor tag. Select the bottom object
and assign it a white stroke with these settings: 
Stroke weight: 6 points
Cap: round 
Join: round 
See Example D.

B

A

C

D

S T E P S
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Here are the steps for creating slogans in the Fanta 
VIS. All slogans in the “Shared” activation quadrant
should be constructed following these instructions to
make sure all variations look and feel like Fanta.

Typography
Use Waldo for all slogans within the “Shared” activation
quadrant. The slogans are constructed as the combination
of an invitation, a theme and product placement. 

For example: 
“Experience The Beach With Fanta now”

Invitation: “Experience”
Theme: “The Beach With”
Product placement: “Fanta now.”

Length
> Slogans longer than 30 characters are to be avoided.
> Avoid more than 15 characters per line. Limit to 12

characters per line for optimal readability.
> Avoid slogans which require more than 2 lines.

Size
> The type will vary in size from line to line according to

content and composition:
Invitation: smallest
Theme: biggest
Product placement: standard

> For slogans with more than 30 characters, place the 
invitation on a separate opening line. 

Color
> There are two backgrounds in the “Shared” activation

quadrant. Use Fanta Blue for slogans on Background
gradient and Fanta Orange for slogans on Background
gradient blue.

> Do not change the colors of the Fanta logotype
(even on the blue background).

> Color variations within a slogan are allowed as long as
the variations support the content.

1. Place slogan typography in the upper left corner of
the composition.

2. Break the slogan into multiple lines by invitation,
theme and product placement. 
See Example A.

3. For three-line slogans make the invitation a separate
object. For slogans consisting of only two lines this
step is irrelevant.
See Example B.

4. Assign font Waldo to both type groups.

CONTINUED ON NEXT PAGE

CUSTOMIZATION : :  TYPOGRAPHY : :  SLOGANS

D E S C R I P T I O N
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5. Type size is not specified, but a good rule of thumb
for a tabloid format is:

Object 1 / Line 1: ”Experience”: 30 points 
Object 2 / Line 1: “The Beach”: 80 points
Object 2 / Line 2: “With Fanta now”: 60 points
Leading: 40 points 

See Example C.

6. Select the copy and double-click the scale tool in the
toolbar. Check “Non-Uniform” and fill in values:
Horizontal: 75% 
Vertical: 100% 
See Example D.

7. Add a warp effect so Object 2 dynamically follows
the circular movement of the swirl. You will choose
warp effect type “Arc” (Effect > Warp > Arc) and
then select the following: 

Vertical or horizontal: vertical
Bend: 6%
Horizontal distortion: -20%
Vertical distortion: 0%

Select “Apply effect.”

8. Again, choose warp effect type “Arc” (Effect > Warp
> Arc) and select the following: 

Vertical or horizontal: horizontal
Bend: 20%
Horizontal distortion: -20%
Vertical distortion: 0%

Select “Apply effect.”
See Example E.

9. Expand the appearance of Object 2 (Object >

Expand appearance).
See Example F.

10. Scale and rotate the expanded object until it fits the
upper left corner and dynamically follows the circular
swirl movement. Position the object about 0.3 inches
from the left edge and about 0.7 inches from the top
edge of the artboard.

Do not overlap the Swirl, including Swirl lines,
Drops and Bubbles.

CONTINUED ON NEXT PAGE
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11. Scale and rotate Object 1 until it fits roughly over 
the first letter in your copy. Here, that’s the “T” in
“The.” Place Object 1 about 0.1 inch above the “T”
of “The” and about 0.3 inches from the left edge of
the artboard.

12. Make sure Object 1 follows the top of the “Th” of
“The Beach” by applying a warp effect. Choose warp
effect type “Arc” (Effect > Warp > Arc) and then
select the following: 

Vertical or horizontal: horizontal
Bend: 40%
Horizontal distortion: 0%
Vertical distortion: -15%
See Example G.

13. Expand the appearance of Object 1 (Object >

Expand appearance).

14. Scale and rotate the expanded object until it fits
over the first letter in your copy. 
See Example H.

15. Assign Fanta Green to Object 1 and Fanta Blue to
Object 2.

16. Group the objects together. Duplicate the grouped
object. Assign the underlying grouped object a
white stroke with the following settings:

Stroke weight: 9 points
Cap: round 
Join: round 

17. To integrate the correct Fanta logotype, select
“Fanta” in both the top and underlying grouped
object with the “Direct Select Lasso Tool.”

18. Delete the selection and place the Fanta logotype
in the now-empty space. 
See Example I.

19. Scale and rotate the Fanta logotype until its fits in
the empty space and follows the direction of the 
slogan (and Swirl). 
See Example J.

H

G
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J

S T E P S  ( C O N T I N U E D )
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Here are the steps for creating slogans in the Fanta 
VIS. All slogans in the “Popular” activation quadrant
should be constructed following these instructions to
make sure all variations look and feel like Fanta.

Typography
All slogans within the “Popular” activation quadrant are 
constructed as the combination of an invitation and 
a theme. 

For example: 
“Join us at the Fanta Beach”

Invitation: “Join us at the”
Theme: “Fanta Beach”

“Meet you at the Fanta Parade”

Invitation: “Meet you at the”
Theme: “Fanta Parade”

For the invitation, use Candyshine.
For the theme, use Waldo.

The invitation should be placed above the Fanta 
logotype and the theme below.

Length
> For maximum readability, both invitations and themes

should be no longer than 15 characters.
> Avoid slogans which require more than three lines.

Color
> Assign Fanta Green to both invitation and theme. 
> Do not modify the colors of the Fanta logotype.

The steps below are broken into two parts: instructions
for the invitation first and then for the theme. 

CUSTOMIZATION : :  TYPOGRAPHY : :  SLOGANS

D E S C R I P T I O N

A

B

1. Open one of the event name lock-up files in
Illustrator or another vector art program. Do not
scale the art before modifying. Delete the existing
slogan. From the toolbar, select the type tool and
type in the new slogan copy.

2. For the invitation type, select Candyshine. Assign a
font size of 14 points and leading of 12 points. 
See Example A.

3. Select the copy and double-click the scale tool in
the toolbar. Check “Non-Uniform” and fill in values:

Horizontal: 75% 
Vertical: 100% 

See Example B.

4. Place the invitation above the Fanta logotype.

CONTINUED ON NEXT PAGE

S T E P S  : :  I N V I T A T I O N
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5. Set the paragraph alignment to “Center.”
See Example C.

6. Add a warp effect. Choose warp effect type “Arc
upper” (Effect > Warp > Arc Upper) and then select
the following: 
Vertical or horizontal: horizontal
Bend: 40%
Horizontal distortion: 30%
Vertical distortion: -15%
See Example D.

7. Expand the appearance of the object (Object >

Expand appearance).

8. Place the expanded object between the “F” of
“Fanta” and the leaf device.

9. Rotate the object until it is parallel with the 
Fanta logotype. 
See Example E.

10. Scale the rotated object until it fits into the space
between the “F” and the leaf device. 
See Example F.

CONTINUED ON NEXT PAGE
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1. For the theme font, select Waldo. Assign a font size
of 50 points. 
See Example G.

2. Select the copy and double-click the scale tool in
the toolbar. Check “Non-Uniform” and fill in values:

Horizontal: 75% 
Vertical: 100% 

3. Outline the theme (Type > Create outlines). 

4. Make an envelope with a mesh to reshape the
object (Object > Envelope Distort > Make with
Mesh). Specify 2 rows and 1 column. 

5. Rotate the object until it is parallel with the 
Fanta logotype. 
See Example H.

6. Reshape the flavor tag with the mesh tool: click 
into the mesh to create anchor points. Reposition
the mesh points and edit direction lines so that the 
slogan organically follows the Fanta logotype. 
See Example I.

7. Expand the envelope (Object > Envelope Distort >

Expand). 

8. Assign both invitation and theme Fanta Green.

9. Group both objects, duplicate the grouped object
and assign the underlying grouped object a white
stroke with the following settings:

Stroke weight: 4 points
Cap: round 
Join: round 

See Example J.

H

I

J

G

S T E P S  : :  T H E M E
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Bottle photography can be used when a photographic
treatment is preferred over the more illustrative style of
the 2-bottle lock-up and the 4-bottle lock-up. 

If you want to create your own bottle photography, 
follow these instructions to integrate the photograph
into your activation:

1. Open your selected photograph in Photoshop. Use
the “Polygonal lasso tool” to separate the bottle from
the background. Delete the background.
See Example A.

2. In a new layer, use the “Polygonal lasso tool” or a
brush with a low hardness percentage to draw the
shadow cast by the bottle. Draw the shadow from
the left of the bottle to the left of the document
where the ground surface would be. Fill in the 
shadow area with black (Edit > Fill).
See Example B.

3. Blur the shadow surface (Filter > Blur > Motion
Blur/Gaussian Blur). If working with a brush instead
of the “Polygonal lasso tool” skip this step.
See Example C.

4. Use a lasso tool to select the left half of the 
shadow cast by the bottle. Feather the selection
(Select > Feather). 
See Example D.

5. Increase the brightness of this selection
(Adjustments > Brightness/Contrast). 

6. Decrease the opacity of the shadow layer to 50%
(Layers > Opacity). 

7. Place both layers in the correct order (bottle layer
on top of shadow layer) in the lower left corner in
the Message area. 
See Example E.

CUSTOMIZATION : :  PRODUCT PHOTOGRAPHY
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The “Core,” “Shared” and “Experimental” activation
quadrants have a unique style of fruit imagery. The style
is simple and stylized, and easy to execute. 

When designing fruits for other Fanta flavors not included
in the Fanta Visual Identity System, remember:

1. Keep it simple! If possible, compose the fruit shape
with standard shapes, such as circles and ellipses.
See Example A.

2. You can combine the shapes into one seamless
shape with the “Pathfinder” tool (Effect >

Pathfinder) or you can leave the shapes grouped
together to create the illusion of depth and shadow.
See Example B.

3. For round fruit shapes (apple, cherry, various berries,
etc.), fill the shape(s) with a color gradient. Select
gradient type “Radial gradient.” Set up the gradient
so that the center of the gradient is the brightest
part, which creates realistic light and shadow areas. 
See Example C.

4. For more complex shapes, position the bright areas
of the gradient with the “Gradient mesh tool”
(Object > Create Gradient Mesh). By using a mesh,
specific areas within the shape can be defined and
assigned a color. 
See Example D.

CUSTOMIZATION : :  FRUIT VARIATIONS
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Two white ellipses
make a reflection

The “Popular” activation quadrant has a different style
of fruit imagery than the other three activation quad-
rants. The style is more hand-done and graffiti-like, a
style that can be easily replicated. 

The Fanta VIS includes a Pop orange, a Pop lemon and
a Pop strawberry. Follow these instructions to create
other ”Pop” fruit.

At all times avoid sharp angles and work only with 
round shapes; rounded strokes with round cap and
round join.

1. In Illustrator or another vector art program, use the
Brush tool to first draw the fruit’s outline. Specify
the “Calligraphic brush” (Window > Brush Library >

Calligraphic) to create a hand-drawn quality to the
outline. Simplify the outline of the fruit to its most
essential and recognizable outline. You may want 
to add any characteristics of the fruit which make 
it more recognizable, such as the green nub on 
the Pop lemon, left. 
See Example A.

2. The stroke color should be Fanta Blue. 
See Example B.

3. Fill in the shape created by the fruit outline. Add a
shadow area to create volume and depth, creating
two shapes for color.

4. Check the Fanta Packaging Guidelines for the 
PANTONE® colors for four flavors: strawberry, lemon,
pineapple and grape. Otherwise, you will need to
specify both a main color and a support shadow
color for your fruit. The colors you choose should
communicate the essence of the flavor but also
work well with the Fanta palette.
See Example C.

5. Create a white reflection within the fruit shape. This
reflection area should be constructed (for more or
less round shapes) as a combination of two ellipses.
See Example D.

CUSTOMIZATION : :  FRUIT VARIATIONS
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ACTIVATION

Final art or mechanical file designed
with the Fanta Visual Identity System
(VIS) for any media.

ACTIVATION QUADRANT

A part of the framework upon which
the Fanta Visual Identity System 
was created and is organized. Each 
activation quadrant is built around
focus, objective, type of media (com-
munications) and longevity.

ADVERTIS ING

Advertising is the activity of 
communicating a message through
the use of print, broadcast and 
electronic media. It is persuasive
in nature, informative and designed
to influence purchasing behavior or
thought patterns.

BACKGROUND: 

TEXTURE AND PATTERN

Pattern is the repetition of an element
in an anticipated sequence with some
symmetry. Texture is the surface
character of the material. Texture
involves our sense of touch but pat-
tern appeals only to the eye; a tex-
ture may be a pattern, but not all
patterns have texture. Both patterns
and textures can be connected to
the brand (i.e., Burberry plaid).

BRAND EXPERIENCE

The brand experience is the impres-
sion a consumer is left with after
encountering a brand or service. 
A consumer’s impression is shaped
each and every time they connect
with a brand and by the quality of
that experience. The quality of the
brand experience is influenced by a
number of factors, including, but not
limited to, the messaging and the
visual imagery, including how it is
presented (e.g., the venue, medium,
layout, typography, color, etc.). 

COLOR PALETTE

The color palette is a specified
group of colors chosen to represent
the brand. Consistent use of color
is used to evoke emotion, indicate
meaning and stimulate brand 
association (i.e., Tiffany blue).

DESIGN

Design is the process of arranging
elements and information in a way
that improves communication.
Design uses text and graphic imagery
to tell a story or express an idea,
visually painting a picture of a brand
or company and its personality. 

Design is not merely just a logo, a
brochure or a website. Design is
everywhere. It incorporates various
communication specialties: graphic
design (visual identity and print),
packaging design (label and form),
industrial design (vehicle and
mechanical), environmental design
(signage and branded spaces), 
fashion design (textile and fashion),
interactive design (web and digital
interface design) and interior design
(materials and interiors). 

Great design is:
> Strategic. It clearly visualizes and

supports the strategy 
> Differentiated. It is one-of-a-

kind, uniquely true to the brand
and both familiar and surprising

> Scalable. It has the ability to
extend across channels and
geographies. It is both flexible
and sustainable

ELEMENTS

Basic, individual pieces of a visual
identity system that when combined
form a more complete and complex
image. 

ELEMENTS /  UNIVERSAL

Essential elements in a visual identity
system which should be included in
every activation. 

ELEMENTS / PRIMARY

Specific, identified design elements
that represent the foundation of a
visual identity system and are
intended for inclusion in all activa-
tions to promote communication
consistency.

ELEMENTS /  SECONDARY

Additional visual elements that are
used, with primary elements, to
bring to life a particular aspect of
brand strategy. Considerations 
for determining which secondary
elements to use depends on the
consumer target for the strategy, 
the environment where the strategy
will be activated, and the message
that needs to be conveyed.

ICON

A person or thing regarded as a 
symbol, especially of a culture or
movement and/or institution. An
icon includes an image that repre-
sents an action, object or concept 
at a higher level of abstraction. This
cultured icon usually emerges over
time and involves a well-established
or easily recognizable image (e.g.,
Michael Jordan or Apple).

IDENTITY

The sum total of all characteristics,
both tangible and intangible, that
make a company/product unique, or
the elements of brand identification
(e.g., the logo, colors, imagery, etc.)
that visually represent the company
and/or product.

CONTINUED ON NEXT PAGE
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PHOTOGRAPHIC AND 

ILLUSTRATIVE STYLE 

The brand's unique visual appear-
ance can be expressed through the
style of photography and illustration.
This can include casting, wardrobe,
lighting, line weight, graphic treat-
ment, environment, composition or
layout. A strong photographic or
illustrative style is recognizable 
even without the brand name (i.e.,
iPod silhouettes).

IN-CONTEXT VISUALS

Examples of how visual identity
guidelines and activations are
applied in real-life situations to com-
municate the brand strategy. 

LOGO

The logo is proprietary art consisting
of a combination of a name and/or a
symbol, and in some cases a short
tag line. At a glance, the logo identi-
fies the nature of your product or
service, defines the benefits and can
single-handedly evoke a company’s
goodwill in the public’s mind. The
logo must be an accurate visual
presentation of the unique personal-
ity of a brand or an organization
(i.e., the IBM horizontal stripe logo).
A logo is only one part of a visual
identity system.

LOGOTYPE

A logotype, or wordmark, is a logo
which employs a purely typographic
solution. Also proprietary art, a logo-
type can be as dynamic and unique
as a logo or symbol.

LOOK AND FEEL

A visual identity system should 
convey the essence of a brand well
enough to communicate an almost
intangible quality that lets the viewer
judge whether an activation is or is
not representative of the brand. 

All activations should have a consis-
tent and recognizable look and feel
across media and time.

READY-TO-USE FILES

Finished artwork for specific activa-
tions that represents appropriate
ways to combine elements under 
a visual identity system and in com-
pliance with the system’s guidelines.

SYMBOL

A symbol is an invented shape or
graphic mark that communicates an
idea or meaning beyond its literal
form. The strongest symbol can
identify a brand with no words (i.e.,
Target’s bull’s-eye symbol).

TYPOGRAPHIC SYSTEM

Typography refers to the distinctive
design of the letters, size, style and
placement of the font. A typographic
system simply means a consistent
use of typographic treatment across
the marketing mix.

VISUAL IDENTITY SYSTEM (VIS )

The visual identity system is a unique
and comprehensive “toolbox” of
imagery that visually communicates
the brand experience consistently
across all consumer touch points. It is
the brand’s style, look and feel. A
visual identity system should include,
but is not limited to, the following:
logo, symbol, color, photography/
illustration style, pattern, texture 
and typography. While it is important
to note that a visual identity system
will evolve over time, certain ele-
ments (e.g., color, pattern) are part
of a brand’s key visual equity and 
will not change.

GLOSSARY



Please contact Jennifer Lowery or Robin Smith 
for approval of any custom activation.

Jennifer Lowery
Creative Excellence
jlowery@na.ko.com
404-676-8595
404-598-8595 fax

Robin Smith
Creative Excellence
robsmith@na.ko.com
404-515-4646

©The Coca-Cola Company. “Fanta” is a registered trademark of The Coca-Cola Company.




